
Functions, Amortization Tables, and What-If Analysis

Absolute and Relative References
Q1: How do $A1 and A$1 differ from $A$1? 

Answer:___________________________________________

__________________________________________________

Use the following table to answer the questions listed below:

A B C D E
1 4 8 =A1/$A$3

2 6 4 =A$1*$B4+B2

3 =A1+A2 1

4
5

a. Q2: What formula would result in cell D1 if you copy the formula from 
cell C1 to D1?

Answer:_____________________________________

b. Q3: What formula would result in cell E5 if you copy the formula from 
C2 to E5?

Answer:_____________________________________

Exercise 2.1
For this problem, you are to copy the following into a worksheet in Excel. Name 
the worksheet “Discount”.  

Next, you are to write a formula in the highlighted cell to calculate the price of the 
scooter after the discount. You should write this formula in such a way that you 
could fill it down and across to calculate the other prices.

When writing this formula, think about which row and columns are going to remain 
constant (absolute referencing), and which will change (relative referencing).

Write down the formula for cell D2 here: _____________________. A correct 
formula will allow you to fill down and then right producing correct results.



A B C D E
1 Item # Product Price After Discount A After Discount B

2 125A Scooter $59.99

3 789A Tricycle $129.95
4

78B
Soccer 
Ball $12.35

5
489A

Crybaby 
Doll $21.99

6 57B Art Kit $14.95
7
8 Discounts
9 A B
10 10% 20%

Debug your work
Select Cell D2  and use “Trace Precedents” 
in the Formulas Tab to see which cells are 
used by cell D2.

Select Cell B10 and use “Trace 
Dependents” to see which cells use B10.  Click “Remove Arrows” to remove the 
tracing lines.

Built in Functions
Functions are special 
routines provided by 
Excel to do simple and 
complex calculations. 
There is no way we can cover all of the functions, but we will look at several which 
will make life much simpler and the rest you can discover as you need them. 
 
Q4: Where do we go to get a feel for the functions that exist in Excel? 

Answer: ___________________________________________

The basic syntax required to invoke a function is carried over from algebra and 
includes the following: 
 

• The function name 
• A left parenthesis 
• A list of arguments where each argument is separated by a comma 
• A right parenthesis 



 
In general, functions take the form: name(arg1, arg2,...) 
 
For example, if a worksheet has values in cells A1 to A5 that we want to add, we 
can do this in several ways: 
 

1. with the formula =A1+A2+A3+A4+A5 
2. =sum(A1:A5)

 
In case 2) above, the name of the function is sum and the argument is A1:A5. 
 
The colon (:) between the cell references indicates a range. So, A1:A5 means 
include the cells A1, A2, A3, A4 and A5.
 
As you can imagine, this function is invaluable if you want to sum up the contents 
of 100 cells in a column. 
 
Notice that Excel is not case-sensitive with names of functions or cells. 
 
Q5: What does case-sensitive mean? 

Answer: ___________________________________________

__________________________________________________

__________________________________________________

A couple of other things to note: 
 

• In general there can be up to 30 arguments in a function. These depend on 
the function itself, and some of the arguments can be optional.

• Cell entries have a 255 character limit by default
• The number and type of arguments depend on the function being used 

 
We know of the following types of arguments for various functions (some of which 
we’ll discuss later):

• numbers 
• cells
• ranges of cells
• text 
• other functions 
• arrays 
• logical values



  
Excel has over 350 built-in functions divided into 10 categories, including financial, 
math&trig, statistical, text, logical, database, and information.  There are really 
two different ways to enter functions into a cell: 
 

1. If you know the function well and the options for parameters, then probably 
just typing away is the best. 

2. Using the “Paste Function” dialog box. To invoke this dialog box, click on the 

fx icon on the tool 
bar.

3. Use the Function 
Library on the 
Formula tab, 
shown at right.

Exercise 2.2

Two incredibly useful functions are INT and MOD. You may or may not have heard 
of these functions, but I would like you to use both of these functions in a 
worksheet and then if I call on you, I want you to be able to describe what they 
do. 

INT  __________________________________________________

_________________________________________________

__________________________________________________

MOD  __________________________________________________

________________________________________________________________________

________________________________________________________________________

Nested Functions
As was mentioned above, it is possible to have functions as arguments in other 
functions. 
 
Q6: Can you think of an example of when we would do this? 



Answer: ___________________________________________

__________________________________________________

__________________________________________________

__________________________________________________

Financial Built-in Functions
The financial functions can be isolated in Excel. Simply go to the Function Library 
on the Formulas tab and select Financial.   Let's study the PMT function. The 
Function dialog box gives the following:

 
If you don't understand exactly what to enter into the fields, then go to the help 
feature and Excel will give you the following help info (in addition to some 
examples):

PMT 
Calculates the payment for a loan based on constant payments and a 
constant interest rate. 

Syntax 
PMT(rate,nper,pv,fv,type)

Where,

• rate is the interest rate for the loan. 

• nper is the total number of payments for the loan. 



• pv is the present value, or the total amount that a series of future 
payments is worth now; also known as the principal. 

• fv is the future value, or a cash balance you want to attain after the 
last payment is made. If fv is omitted, it is assumed to be 0 (zero), 
that is, the future value of a loan is 0. 

• type is the number 0 (zero) or 1 and indicates when payments are 
due. 

• Set type equal to 0 or omitted if payments are due at the end of 
the period 

• Set type equal to 1 if payments are due at the beginning of the 
period 

Remarks 
 The payment returned by PMT includes principal and interest but no 

taxes, reserve payments, or fees sometimes associated with loans. 

 Make sure that you are consistent about the units you use for 
specifying rate and nper. If you make monthly payments on a four-
year loan at an annual interest rate of 12 percent, use 12%/12 for rate 
and 4*12 for nper. If you make annual payments on the same loan, 
use 12 % for rate and 4 for nper. 

 
Tip: To find the total amount paid over the duration of the loan, multiply the 
returned PMT value by nper. 

Examples 
a. The following formula returns the monthly payment on a $10,000 loan at an 

annual rate of 8 percent that you must pay off in 10 months: 

=PMT(8%/12, 10, 10000) equals -$1,037.03

b. For the same loan, if payments are due at the beginning of the period, the 
payment is: 

=PMT(8%/12, 10, 10000, 0, 1) equals -$1,030.16

c. The following formula returns the amount someone must pay to you each 
month if you loan that person $5,000 at 12 percent and want to be paid 
back in five months: 



=PMT(12%/12, 5, -5000) equals $1,030.20

d. You can use PMT to determine payments to annuities other than loans. For 
example, if you want to save $50,000 in 18 years by saving a constant 
amount each month, you can use PMT to determine how much you must 
save. If you assume you'll be able to earn 6 percent interest on your savings 
per year, you can use PMT to determine how much to save each month. 

=PMT(6%/12, 18*12, 0, 50000) equals -$129.08

If you pay $129.08 into a 6 percent savings account every month for 18 
years, you will have $50,000. 

Exercise 2.3
When purchasing large and expensive objects (such as cars, furniture, boats, etc) 
most of us cannot afford to pay for them right away. Instead, we take out a loan 
on the object for a certain interest rate and period and pay it back monthly.
 
Now, let’s imagine that you want to purchase a car worth $29,899. The car dealer 
is ready to grant you a 5-year loan at 6.5% annual interest rate, but you must put 
down 10% of the car price as down payment. 
 
Design an Excel spreadsheet called "Car Dealer" to allow the user the ability to 
input:

a. The price of the car
b. The yearly interest rate 
c. The period of the loan in years

           
Your spreadsheet should then compute and display:

d. The amount of the down payment
e. The amount of the loan 
f. The monthly payment of the loan

 
Be sure to Name each of the input cells appropriately.

Q7:  How can we calculate the total interest that has been paid on this loan? See if 
you can include this calculation in your worksheet. 

Answer: 
________________________________________________________________________

________________________________________________________________________



Submitting Assignments
Name the worksheet you created in Exercise 2.3 ‘Car Loan’, and save the 
workbook to the desktop as ‘02XXXXXXXX’, replacing XXXXXXXX with your 
PUNetID. For example, my workbook would be called ‘02will4614’.

Connect to \\turing.cs.pacificu.edu\students, and copy the worksheet you created 
to the folder named ‘CS130 Drop’. This is how you will submit your assignments.

You should also save a copy to your own folder on turing. Copy the worksheet 
from the desktop to your folder in \\turing.cs.pacificu.edu\students\CS130-
Spring2010Accounts.

Exercise2.4
Let’s return to the worksheet you created in Exercise 2.3. Before you make up 
your mind about buying the car, you would like to see a table of the payment 
schedule. Specifically, you want to see for each monthly payment the payment 
number, starting balance, monthly payment, monthly interest, and ending 
balance.
 
Add a payment schedule to your spreadsheet. Your spreadsheet should have 
columns for (1) payment number, (2) starting balance, (3) monthly payment, (4) 
monthly interest and (5) ending balance for each of the 60 payments. 

The first few lines of your payment schedule should contain the following:

Payment Starting Balance Payment Interest Ending Balance
1 $26,909.10 $526.51 $145.76 $26,528.35
2 $26,528.35 $526.51 $143.70 $26,145.54
3 $26,145.54 $526.51 $141.62 $25,760.65
4 $25,760.65 $526.51 $139.54 $25,373.68
5 $25,373.68 $526.51 $137.44 $24,984.61
6 $24,984.61 $526.51 $135.33 $24,593.44
.. …. …. …. …..

Use filling and cell referencing (both relative and absolute) as much as you can 
while creating this table.
 
Q7: How can you be sure that your payment schedule is correct? 

Answer: ___________________________________________

__________________________________________________

__________________________________________________



Q8: Does your table still give the correct values if the interest rate is changed to 
6%?

Answer: ___________________________________________

__________________________________________________

__________________________________________________

What-If Analysis and Goal Seeking
Using Excel to scrutinize the impact of changing values in cells that are referenced 
by a formula in another cell is called what-if analysis. 

 
Let us perform what-if analysis on exercise 2.5 using the "Goal Seek" function 
found with-in What-If Analysis in the Data tab.:
 
Q8: How much car can I afford if I am willing to pay $600 a month under the 
initial scenario?

Answer: ___________________________________________

__________________________________________________

__________________________________________________

If we know the result that we want a formula to produce 
then we can use goal seeking to determine the value of 
a cell on which that formula depends.

Exercise2.5
Name the worksheet “Birthday”

You've just realized that it's your mother's birthday in six weeks time. You have 
found the ideal gift for $100. You don't have a penny on you at the moment, but 
you work at the local grocery store for 12 hours a week and make $4.50 an hour. 



Since you have been keeping track of your accounts for the last six months you 
know that your expenses (food, rent, etc.) generally use up 80% of your wages.
 
Create an Excel worksheet to work out:

• The total amount of money you will make in 6 weeks
• Your total expenses for six weeks
• The amount of money that you will have left over for the gift.

 
Unfortunately, the amount of money that you have left over will not be enough for 
that perfect gift.
 
Use the (Goal Seek) command to determine:

• The number of extra hours a week you will need to work to reach your goal
• If you choose not to work any extra hours then you will need to lower the 

percentage of your salary that you use on expenses. What will this 
percentage now be?
Write your answer here: ___________________________
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